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Chapter 7  

 

A Quick Tour of ArcGIS Desktop (ArcMap) 

  
 
 
 
 
 
 
 
 
 
 
 
Skills you will learn: This tutorial is intended to get you going using ArcMap, which 
is the traditional desktop application that is part of ArcGIS Desktop. The latest 
versions of ArcGIS Desktop also include an application known as ArcGIS Pro, which 
may supersede ArcMap in time.  A separate tutorial gives a basic overview of ArcGIS 
Pro. 
 
This tutorial assumes you have installed ArcMap Basic or Advanced on your 
computer and that you are using version 10, which as of the writing of this tutorial is 
in version 10.4.1. Illustrations in this tutorial depict functionality in ArcMap 10.4.1. 
 
Throughout this tutorial, we will use a shapefile of Toronto electoral wards available 
from the City of Toronto’s open data website at 
http://www1.toronto.ca/wps/portal/contentonly?vgnextoid=b1533f0aacaaa210Vgn
VCM1000006cd60f89RCRD   We used the 2010 ward map, with the NAD27 datum. 
 
 
Getting started, the basics 
 
ArcMap is a sophisticated and powerful application that has been refined over many 
years. It is not always the most intuitive program to use, and features typically used by 
journalists are accessed via a potentially bewildering array of menus, toolbars, and 
icons. The purpose of this tutorial is to provide you with a roadmap to the most 
important features. 

http://www1.toronto.ca/wps/portal/contentonly?vgnextoid=b1533f0aacaaa210VgnVCM1000006cd60f89RCRD
http://www1.toronto.ca/wps/portal/contentonly?vgnextoid=b1533f0aacaaa210VgnVCM1000006cd60f89RCRD
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Chapter 7 of The Data Journalist provides an introduction to how journalists use GIS 
programs, as well as important theoretical background for using any GIS, and it 
should be read prior to working with this and the other tutorials. 
 
When you first open ArcMap—assuming you have left the default options in place-- 
you will be presented with this Getting Started screen. If you are using a file 
geodatabase to store map layers, as discussed later in this tutorial, you can set that 
layer as the default geodatabase for the map as part of this dialogue. 

 
 
In the illustration above, clicking OK will open a new blank map. 
 
 
The map document 
 
In ArcMap, all of the information about how a map is put together is stored in what 
Esri calls a map document, or .mxd file. The .mxd file doesn’t contain the actual map 
data, but instead contains pointers to the various layers and datasets that go together 
to make the map. The layers may be Esri shapefiles or feature classes stored in 
geodatabases. Datasets may be .csv files, Excel files or in relational databases if open 
database connectivity (ODBC) is used. You can also connect to a Microsoft Access 
database. Instructions for the latter task are available at 
http://desktop.arcgis.com/en/arcmap/10.3/manage-data/tables/connecting-to-a-
microsoft-access-database.htm 

http://desktop.arcgis.com/en/arcmap/10.3/manage-data/tables/connecting-to-a-microsoft-access-database.htm
http://desktop.arcgis.com/en/arcmap/10.3/manage-data/tables/connecting-to-a-microsoft-access-database.htm
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The data frame 
 
In ArcGIS, the map on which you are currently working appears in what is called the 
data frame, by default positioned to the right of the screen. It is the darker area in this 
illustration. 
 

 
 
The various layers that make up the map are shown in the table of contents, by 
default to the left. The table of contents has four available views, represented by the 
four icons across the top. From left to right, you can show the layers by their drawing 
order, by their source (location on your hard drive or in a geodatabase), by whether 
they are currently visible in the data frame, and by whether they are selectable. You 
can make layers visible or invisible by clicking on the checkmark beside the layer’s 
name in the drawing order and source views, or in the properties for the layer 
(discussed later in this tutorial). Here, we see the drawing order view. 
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Catalog Window 
 
The Catalog window, available by clicking on the Catalog icon, is an inline version of 
the ArcCatalog application that ships with ArcMap. Today, the window is mostly used 
for certain specialized file management functions, such as creating an address locator 
for geocoding, creating an ODBC connection to an external data source such as a 
Microsoft Access database, adding a folder connection, or creating a new file 
geodatabase. Geocoding is discussed in the tutorial Geocoding in ArcGIS Desktop. 
We discuss file geodatabases below.  Here is an image the catalog window: 

 
 
The table of contents and the catalog window can be moved to either side of the data 
frame, or the top or bottom of the frame, and either can also be pinned to the side of 
the frame, or allowed to float freely.  
 
Adding data to the data frame 
 
We can begin a new analysis in ArcMap begins with the addition of one or more 
datasets to the data frame. We’ll discuss adding map layers first. 
 
ArcMap can directly open shapefiles, feature classes contained in file geodatabases, 
and ArcMap layer files. See chapter 6 of The Data Journalist for a discussion of 
different map data formats. ArcMap also has conversion utilities that allow you to 
convert formats such as KML for use in ArcMap. Some require extra-cost extensions. 



5 
 

If you are adding a shapefile, feature class from a geodatabase, or a layer file, click on 
the Add Data icon on the standard toolbar. 

 
 
This opens the add data directory dialogue. 
 

 
 
If you have not done so already, you will need to create a connection to the folder 
that contains your data. You can create a connection to a folder as high in your folder 
hierarchy as you like, including to a root drive on your computer. It is usually more 
convenient, however, to create a connection to the specific directory that contains 
your data. That way the data is easily accessed without having to navigate to the folder 
every time. 
 
Click on the icon of a small file folder with a + sign, navigate to the directory location 
you are going to use for the connection, then click OK. 
 
The connection will now appear under folder connections. 
 
Adding a layer to your map is now a matter of going to your folder connection, and 
navigating to the actual folder that contains the map data you wish to add. If the data 
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is in a file geodatabase, you will need to double click on the file geodatabase name, 
and select the layer from the list in the geodatabase.  
 
Here is the data frame showing a map of Toronto, Ontario municipal electoral 
districts, obtained from the city’s open data site in Esri shapefile format and added to 
the frame. 
 

 
 
 
Adding non-geographic datasets 

 
You are not limited to adding map layers to your map document. You can also add 
non-geographic data, often as a first step to joining the data with a geographic layer as 
described in the tutorial Joining Maps to Other Datasets in ArcGIS. 
 
The task of adding non-geographic data is so common that delimited text files (see 
chapter 2 of The Data Journalist for a discussion of various data formats) are a native 
file type that can be added directly to a map document. Any file with a .csv or .txt 
extension will be assumed to be a comma-delimited file, while any file with a .tab 
extension will be assumed to be a tab-delimited file. The most recent versions can also 
work with Excel format files.  
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To add a non-geographic file to the map document, simply click on the Add Data 
button, and navigate to the folder containing the file. It will then be added to the table 
of contents. 
 
ArcMap uses its own set of rules to determine the field types for the columns in the 
delimited text file.  Normally, this works fine. Columns that are obviously numbers 
will be imported as number types, while text fields will be imported as text types. 
Occasionally, however you will need to import a text file that has fields with 
ambiguous data. For example, Canada’s national statistical agency, Statistics Canada, 
identifies some urban census tracts with numbers that have trailing 0s after a decimal 
place, a such as 20400078.00. ArcMap interprets these columns as being number 
columns, and strips off the trailing 0s. This is a problem because if one is joining the 
data in the census file with a map of census tracts, the trailing 0s need to be intact to 
make the join properly. 
 
Fortunately, there is an easy fix. If you have such a file, create another text file and call 
it schema.ini. Place it in the same folder as the text file you want to import. In the 
schema.ini file, you need to two lines. The first identifies the file to be imported, and 
the second sets the field in question to be imported using the data type you want. 
For example, consider this csv file with two fields: 
 
ID, Population 
2345.00, 1246 
678.00, 2129 
453.12, 1047 
 
ArcMap would normally interpret the ID column as a number type, as well as the 
Population column. For the population column, this is correct, but the ID column 
needs to be imported as text, because the trailing 0s are an integral part of the ID field 
value. 
 
To fix this, created a schema.ini file containing this: 
 
 [test.csv] 
Col1= ID Text 
 
This would tell ArcMap to import column 1, which has the name ID, as a text field. 
To control how more than one column is imported, just add additional column 
instructions, each one on a new line. 
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You can read more about this issue at 
http://resources.arcgis.com/en/help/main/10.1/index.html#//005s0000001000000
0 
 
Once you have some data in the data frame, you can begin to work with it.  
 
 
The layer menu 
 
Once the layer has been added to the data frame, its name will appear in the table of 
contents. In the drawing order, source, and visibility tabs, if you right click on the 
name of the layer, a new menu will open, as seen here.  
 

 
 
There are a number of key choices in this menu that are at the centre of most 
workflows in ArcMap. Some of these lead to further submenus, which we will discuss 
as we get to them. 
 

http://resources.arcgis.com/en/help/main/10.1/index.html#//005s00000010000000
http://resources.arcgis.com/en/help/main/10.1/index.html#//005s00000010000000
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Copy allows you to copy the layer to the clipboard and then paste an identical copy 
into this or another map document, while remove does exactly what it suggests, 
removing the layer from the map document. 
 
If you click on Open Attribute Table, you will be able to see the underlying attribute 
table for the map layer. See Chapter 7 of The Data Journalist for a full discussion of 
attribute tables and the nature of map layers as data tables. 
 
This is what the attribute table of the Toronto election wards map looks like when 
opened. 
 

  
 
We’ll return to attribute tables later. 
 
Back in the layer menu, the Joins and Relates option is used to create joins and 
relations between tables, including between geographic and non-geographic data. This 
functionality is explained in two additional tutorials, Joining Maps to Other 
Datasets in ArcGIS and Spatial Joins in ArcGIS Desktop. 
 
The Selection menu item is covered in the tutorial Selecting by Attributes and 
Location in ArcGIS Desktop. It allows you to work with selections on the map 
and/or the attribute table. 
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The Label Features item toggles text labels on and off. The text displayed, and its 
format, can be controlled using the Label Manager. It is accessed via the Labeling 
Toolbar, which can be made visible by selecting Labeling in Customize>Toolbars. 
 

 
 
The Edit Features menu item can be used to start an editing session on the layer, to 
modify features, add new ones, or delete features. 
 

 
 
 
Clicking Data opens a submenu in which you can initiate an export of the map data 
in the layer.   
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When you choose Export Data, a file dialogue opens.  You can choose to export the 
data with the coordinate system used by the layer, or the current coordinate system 
being used by the data frame (see the discussion of the data frame properties menu 
item later in this tutorial). See chapter 7 of The Data Journalist for a discussion of 
coordinate systems. 
 

 
 
 
You can choose to export either to a shapefile or to a new feature class in a file 
geodatabase.  Click on the file folder icon to make these choices. 
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. 
Once exported, the new layer can be added to the data frame, at your option.  
 
Data export is often used after you have joined non geographic data to a geographic 
layer and you wish to have a new geographic layer that includes the attributes from 
both. 
 
The Save as Layer File menu option will save the layer to a layer file in ArcMap. 
This is often used after making a selection, as discussed in the tutorial Selecting by 
Attributes and Location in ArcGIS Desktop. 
 
The last menu item, Properties, opens the properties dialogue for the layer, which 
again, offers a blizzard of options, the most important of which we will cover here. 
 
The General tab allows control of basic properties, such as the name of the layer (the 
name only applies within the map document; the original name of the layer is not 
altered), whether it is visible (also controlled by the checkbox in the table of contents), 
and whether the layer is visible at all zoom levels, or only at some. 
 
The Description area allows you to add your own description, such as where you got 
the layer, who provided it, and why you chose to use it. You can use the credits area 
to credit the source of the map layer. 
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The Source tab provides important metadata, such as the location of the file in your 
computer’s file system, the type of feature (point, line, polygon), the projected 
coordinate system,  projection and unit of linear measure of the layer, and the 
geographic coordinate system, datum and unit of angular meaure of the layer. A quick 
glance at this data can help you determine if, for example, the map layer is 
unprojected. Please see the discussion of coordinate systems in Chapter 7 of The Data 
Journalist for a more complete explanation of what coordinate systems are, why they 
are used, and what you must consider when using them.  
 
The Selection tab allows you to control how selected features will be highlighted on 
the map layer. 
 
The Display tab gives you control over how the layer will be displayed, including 
whether it is opaque or transparent. You control the transparency, which is the degree 
to which other layers below the layer will be visible through it, by varying the 
transparency value from 0 per cent up to 100 per cent. Of course, at 100 per cent, the 
layer would not be visible. 
 
The Symbology tab is used when creating choropleth maps, categorical maps, and 
other specialized display formats. See the tutorial Making Choropleth Maps in 
ArcGIS Desktop for a discussion of how to make categorial and choropleth maps. 
 



14 
 

The Fields tab allows you to determine which fields will be visible in the attribute 
table and in the HTML popup. Finally, the HTML Popup tab allows you to control 
how the HTML popup will appear. 
 
 
Menu for non-geographic tables 
 
When you add a non-geographic file to the table of contents, you can right click the 
file name to see a more limited menu of options than is available for a map layer file.  
 

 
 
The three most important menu items are Geocode Addresses, used to access the 
geocoding routine for turning non-geographic data, such as addresses, into geographic 
data for display on the map, Joins and Relates, and Display XY Data, which is used 
to display points represented in a non-geographic data file as latitudes and longitudes 
or as Cartesian coordinates. See Chapter 7 of The Data Journalist for a discussion of 
these concepts. Procedures for geocoding and adding XY data are found in the 
tutorial Geocoding in ArcGIS Desktop. 
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Working with attribute tables 
 
A GIS program is a sophisticated database application, and there are various ways to 
work with a map layer’s attribute table. 
 
The leftmost icon at the top of the table is the table options icon. If you click on this 
icon, you will see a menu of options for working with the table data, as seen here.  
 

 
 
 
As is often the case in ArcMap, there are a great many menu options. We will focus 
on a few key features. The Select by Attributes choice is covered separately in the 
tutorial Selecting by Attributes and Location in ArcGIS Desktop.  
 
The Add Field item enables you to add a field to the table, including the data type 
and length for the field. 
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Once you have added the field you can populate it using the Field Calculator (see 
below). 
 
The functionality of Joins and Relates is covered separately in the tutorial Joining 
Maps to Other Datasets in ArcGIS. 
 
The Print menu item allows you to print out your table, while the Export item allows 
you to export the attribute data in the table to an outside table. You might do the 
latter if you need to do further calculations on the data in Excel, or upload it for use 
in another application. You can export to any folder to which you have established a 
folder connection. 
 

 
 
As you can see from the image, there are a number of available export formats, 
including a table in a file geodatabase, a dbase database format table, and a delimited 
text file. 
 



17 
 

The field calculator 
 
If you have added a field to an attribute table, you can populate it manually by 
opening an editing session for the table, or by using the field calculator to populate 
the field in bulk. 
 
Right click at the top of the field to bring up another submenu. From this menu, 
choose Field Calculator. 
 

 
 
ArcMap will ask you if you want to do your calculation outside of an edit session. If 
you need to be able to undo your actions, click No, then on the Editor toolbar 
(accessible under Customize>Toobars), to start an editing session. You can also start 
an editing session by choosing Edit Features>Start Editing, on the individual table 
menu.  If you are simply adding data to an empty field, you should be able to go ahead 
outside of an editing session, so click Yes. 
 
The Field Calculator dialogue is extensive and flexible, and again too richly featured to 
cover in full here. It allows you to populate the field not only with new values, but 
with values derived by running functions written in Python of VB Script code, such as 
string functions and date functions, depending on the type of field you have created. 
 
To simply insert a constant text value into the new field, choose the String data type, 
then type the new value for the field into the box at the bottom of the dialogue, in 
double quotation marks. In this illustration, we are putting the value “Toronto” into 
every row of the table, in the new field. 
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The ArcMap inline documentation explains the field calculator in detail. Click on 
About Calculating Fields. 
 
 
Other ArcMap toolbars and menus for frequently performed tasks 
 
ArcMap has a great many toolbars and menus. Luckily, most of the key features you 
will use are found in just a few. We’ll walk through some of the most important 
features by taking a tour of these interface elements. 
 
 
Toolbars 
 
ArcMap has numerous specialized toolbars that you can turn on and off by choosing 
Customize>Toolbars. The two that are turned on by default and used most often are 
the standard and tools toolbars. 
 
This is the standard toolbar. 
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From left to right, the icons allow you to create a new map document, open an 
existing map document, save the map document, print the map document, cut a 
selected map feature, copy a selected map feature, paste the clipboard contents into 
the map, delete a map feature, undo adding a layer, and redo a previously undone 
action. Continuing to the right, the icon showing a black plus sign overlaid on a 
yellow diamond is the Add Data control, which we discussed earlier.  
 
Continuing to the right on the standard toolbar, the next item is the scale control.  
You use this to set the scale for the map using a ratio rather than by using the zoom 
controls on the tools menu. In this image, the map is set to a scale by which one 
metre on the map represents 271,886 metres in the real world. 
 

 
 
There are five more icons in the standard menu that you will use often. 
 

 
 
From left to right, the editor icon opens the editing toolbar, with which you can edit a 
map layer, doing such things as removing features, changing the shape or length of 
features, changing attributes, and removing vertices (the points that define the outside 
of a polygon).  The next icon to the right displays or hides the table of contents, while 
the icon showing a tiny filing cabinet opens the catalog window, used for a variety of 
file management tasks. The search icon, next to the right, allows you to search for 
map layers (if you have “registered” folders for indexing by ArcMap), datasets, 
address locators used in geocoding, and, especially useful, various ArcMap tools. The 
latter function can save time because various tools are accessed in different locations 
and different ways, making the search function a good shortcut when you are not sure 
where to find the tool you need.  
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The icon with the red toolbox opens the Arc Toolbox, which contains many tools for 
manipulating and analyzing your data.  
 
The second toolbar that is opened by default is the Tools toolbar. It looks like this. 
 

 
 
From left to right, the +  and – magnifier icons are used to increase or decrease the 
zoom level (scale) in the data frame.  
 
Once activated, you click somewhere in the data frame, and the map will zoom in or 
out. You can also use the + icon to draw a rectangle on top of the map layer(s) in the 
data frame, and the map will zoom in to include the area bounded by the rectangle. 
 
Here, an area has been selected. 
  

 
 
Which zooms the frame like this: 
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Continuing to the right on the toolbar, the hand symbol allows you to drag the layers 
in the map frame in any direction, just as you would pan over an online map. 
 
The globe icon is used to zoom the map layers to their full extent, which means the 
entirety of all layers is visible in the data frame. 
 
The next two icons, with the four arrows pointing inward or outward, zoom in and 
out from the current centre of the data frame. 
 
The blue arrow icons, pointing left and right, are like the forward and back buttons on 
a web browser, and allow you to go back and forth between zoom levels selected 
earlier. 
 
The next icon is the select features tool, and by clicking on the downward-pointing 
arrow, you can select one of five select tools. 
 

 
 
Relatively self-explanatory, these tools allow you to draw different shapes over the 
layers in the data frame, selecting all features that are fully or partially within the area 
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you select. The select by rectangle tool also will select any feature by simply clicking 
on it. You can find out more about selecting features in the tutorial Selecting by 
Attributes and Location in ArcGIS Desktop. The behaviour of these select tools 
can be modified in the ArcMap options (see below). 
 
The next icon to the left is used to clear all selected features. It is grayed out when no 
features are selected. 
 
When selected, the blue circle with the letter i contained within it, will cause an 
information window to pop up when the user clicks on a feature on the map. Here, 
the user has clicked on one of the Toronto wards to identify it and see the attribute 
fields associated with that feature. 
 

 
 
The icon that looks like a cartoon bubble is used to view the HTML popup for a 
feature. The HTML popup shows attributes for the feature in a formatted window. 
How the popup is configured can be changed in the properties for the map layer, 
which are discussed later in this tutorial. 
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Clicking the ruler icon turns the cursor into a measuring tape. Click on one point on a 
layer, then click on a second point, and the distance between them in the units of the 
map will be displayed. 
 

 
 
The binoculars icon opens the find dialogue, which allows you to quickly find features 
on the map using text searches. You can also search for addresses if you have created 
an address locator (see the geocoding tutorial) or you want to use ArcGIS Online 
credits, for which there is a charge. 
 
The XY icon permits you to find a location on the map by entering its latitude and 
longitude, and the viewer icon, the last on the right, enables you to open a new 
window for viewing your map or a magnifier window that allows you to zoom in on a 
desired part of the map without having to change the zoom level of the main data 
frame. 
 
You can change the icons that appear in these toolbars, and see additional toolbars, all 
through the Customize menu. 
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Menus 
 
ArcMap has a number of menus beyond those we have already looked at, some of 
which you will use frequently. The File Menu, seen here, is much like the file menu in 
other applications. 
 

 
The New, Open, Save, Save As, and Save a Copy menu items are for file operations 
related to map documents. The Add Data submenu contains commands for adding 
various types of layers to the map frame. 
 

 
 

The top item in this submenu duplicates the Add Data icon, which duplicates the Add 
Data icon on the standard toolbar. The Add Basemap item allows you to add base 
layers from the ArcGIS Online service. This also duplicates functionality available 
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from the Add Data icon. The Add XY Data item allows you to add points to the map 
contained in a data table that has columns for X and Y coordinates, such as latitudes 
and longitudes or UTM coordinates. The Geocoding item opens the geocoding 
process. See the tutorial Geocoding in ArcGIS Desktop for details on how to 
geocode addresses in ArcMap. 
 
Back on the main file menu, the print item allows you to print the map shown in the 
data frame. The Export Map item allows you to export the map image to a number of 
formats including PDF, JPG and EPS. 
 
Under the View menu you can review the data frame properties, including appearance 
elements such as the background colour, and the coordinate system being used by the 
frame. As discussed in chapter 7 of The Data Journalist, the projection of the first layer 
added to the data frame determines the projection used by the data frame, and 
additional layers are projected on the fly to match the projection of the frame. In the 
data frame properties dialogue, you can change the projection used by the map frame 
to any that you choose. As discussed in chapter 7, if the underlying geographic 
coordinate system used by the map frame is different from the coordinate system of 
the layer you are adding, a transformation will be required to ensure layers align 
correctly. 
 
The Selection Menu provides functionality to select features on a map by location 
and by attributes. See the tutorial Selecting by Attributes and Location in ArcGIS 
Desktop for step by step instructions. The menu also allows you to change the 
behaviour of ArcGIS when you manually select features on the map, such as creating 
a new selection or adding to an existing selection, and change options for how the 
select tools work. 
 
The Geoprocessing menu, seen below, contains a number of features for 
manipulating geographic data. 
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The buffer tool allows you to draw buffers around the outside of polygons, around 
points, and along lines. You can learn about buffer analysis in the tutorial Buffering 
in ArcGIS Desktop. 
 
Search for tools allows you to perform a text search for different ArcGIS tools. This 
is a useful feature because various tools are scattered in different locations in the user 
interface. 
 
The Geoprocessing Options menu item opens the geoprocessing options dialogue. 
This allows you to control such things as whether the output of operations such as 
buffering is overwritten when you run the operation again, or simply will not execute, 
whether the output of geoprocessing operations is displayed on the screen, and 
whether geoprocessing operations run in the background, allowing you to continue 
working in ArcMap, or in the foreground. While foreground processing prevents you 
from doing other work with ArcGIS, it uses fewer system resources and may be 
desirable for memory-intensive tasks that would otherwise slow your computer to 
molasses. 
 
The Customize menu, seen here, controls which of more than 30 ArcGIS toolbars is 
displayed, as well as allowing you to set a variety of options for ArcMap itself. 
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Choosing ArcMap Options brings up this dialogue. 
 

 
 
Some of the key choices in the General Tab include: 
 

 Immediately Add Data:  If checked, the Add Data dialogue will open when 
ArcMap starts. 
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 Load Last Map on Startup: If checked, the map open the last time ArcMap was 
open will reopen. 

 Make Newly Added Layers Visible by Default: When checked, newly added 
layers will be visible in the data frame. If unchecked, you will need to make 
them visible if you want to see them. 

 Return to Last Used Location when Add Data dialog first used: As the 
description suggests, when this checkbox is ticked, the add data dialogue will 
automatically go to the directory or other location you used the last time when 
adding data. 

 
 
File geodatabases 
 
The various analysis methods and tools that produce new map files as their output, 
including spatial joins, buffering, geocoding, and exporting map tables, can produce 
new shapefiles. In most cases, this will be perfectly sufficient. However, there may be 
times, such as when you geocode hundreds of thousands or more points, when the 
technical limits of a shapefile will be reached. In these cases, you will need to save 
your output to a file geodatabase. In addition, if you prefer, you can use a file 
geodatabase as part of your routine workflow. 
 
A file geodatabase is a newer type of storage available in ArcMap that stores layers 
and data tables in a special type of database, not dissimilar in concept to a database in 
Microsoft Access or MySQL.  
 
If you wish to create a file geodatabase, you will need to use the Catalog window. Go 
to Folder Connections, navigate to a folder where you would like to create the file 
geodatabase, then click New>File Geodatabase. Give the geodatabase a name, and 
you should be all set to go. The geodatabase will now be available whenever you are 
creating new map layers, which are known as feature classes when contained in a file 
geodatabase. Choose File and Personal Geodatabases as the type of file to save to and 
select the geodatabase you created earlier, when using tools that create new map files. 
You can add layers contained in file geodatabases to your map document, using the 
Add Data dialogue discussed earlier. 
 
File geodatabases have effectively limitless capacity, as you will more likely be limited 
by the file size constraints of your operating system or hard drive than you will by the 
limitations of the file geodatabase itself.  As an example, a single feature class can be 
up to 1 terabyte in size, and with additional settings, can be a quarter of a petabyte. 
Few computers being used by journalists will have hard drives of more than a few 
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terabytes. Solid state drives common on today’s laptops rarely exceed 1 TB in size. 
The article found at http://www.esri.com/news/arcuser/0309/files/9reasons.pdf 
provides useful background on the benefits of using file geodatabases. 
 
ArcMap also has a database type called a personal geodatabase, but we would 
recommend using the file geodatabase type. 
 
 
Converting a map layer to a KML file 
 
You can export the geographic information in a shapefile or feature class in a file 
geodatabase to the kml format for use in online mapping services such as Google 
Fusion tables, as long as it is not a very large file. Generally, a polygon file 
representing an urban area will be small enough to upload to Fusion Tables (as a kml) 
as will a file of a few hundred points. 
 
To begin this process, make sure the shapefile you wish to export is open in your map 
document. If you wish, choose the fields you wish to export by selecting fields in the 
fields tab of the properties dialogue for the map layer, as discussed earlier in this 
tutorial. You can also choose whether to export the attributes to appear in a bubble by 
ensuring the “Show content for this layer using the HTML popup tool” checkbox is 
ticked off in the HTML popup tab of the properties dialogue. 
 
Click on the red toolbox icon to open the ArcToolbox. Navigate to Conversion 
Tools>To KML>Layer to KML.  
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A new dialogue will open. Choose the shapefile you wish to convert using the 
dropdown list. Choose a name for the output kmz file (a zipped kml file). Finally, 
enter a scale for the output file; 10,000 will work fine. Click OK, and the conversion 
will proceed.  
 
To convert the kmz file to a kml, go to your windows file explorer or Mac Finder, 
find the kmz file you just created, and add an extra extension of .zip to the file name. 
This will trick Windows or OS X/macOS into letting you use the extract 
function/open function to extract the kml file. Once extracted, rename it to reflect its 
contents, and it will be available to upload to Fusion Tables. Once uploaded, you can, 
for example, merge it with another Fusion Table to make a thematic map using 
buckets. 
 
 
 
 


